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FORGE Application Generator for CP30 Mobile Computers, featuring easy-to-use and 
quick-to-apply, is designed for the users of Windows mobile computers to develop 
custom templates for the use with AG application on the mobile computers. Users are 
then able to define their own data collection templates on any desktop computer without 
spending time writing any program code.  

FORGE Application Generator is used to develop applications for many purposes, such as 
– 

 Receiving in Retail 

 Price Check 

 Product labeling & Tracking 

 Shelf Product Replenishment 

 Mobile Point of Sale (POS) 

 Mobile Inventory Management 

 Order Picking & Staging 

 Work-In-Process Tracking 

 Material Flow Control 

 Transportation & Distribution 

 Warehousing 

 Asset Management 

 

After having configured and saved your template, copy or move the template file to the 
mobile computer. When running the AG application on the mobile computer, data 
collection can commence immediately by making use of the template specified. 

This manual serves to provide comprehensive understanding of FORGE Application 
Generator for CP30 Mobile Computers, and helps define custom template for a specific 
application. We recommend that you read the document thoroughly before use and keep 
it at hand for quick reference.   

Thank you for choosing CipherLab products! 
 

INTRODUCTION 
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SYSTEM REQUIREMENTS 

To run the program, one of the Windows operating system is required: 

 Windows 2000 

 Windows XP 

 Windows Vista 

 Windows 7 

FEATURES 

 Supports CipherLab Windows Mobile 6.5 mobile computers  

 Definition of program flow 

 Editing of screens and data 

 Managing barcode reader  

 Supports camera and program localization options 

 Password-protected user settings to prevent unauthorized user intervention 

 Definition of system initial settings for a quick start 

 Easy cloning by delivering the template file 
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INSTALLING FROM THE CD-ROM 

1) Insert the CD installer into the CD-ROM and run CP30_WM.exe on the product CD:  

 

2) Click “Next”, select “I accept the terms in the license agreement” check box then click 
“Finish”. 
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3) After installing, the mobile computer screen will show you the successful installation 
information as below: 

 

4) Please run AGCP30.msi on the product CD to install Forge Application Generator on 
your computer. 
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5) Click “Next” to indicate the root to install the Fore Application Generator, and then 
click “Next” to continue. 

 

6) Click “Next” to start the installation. 
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7) Click “Close” to exit and finish the installation. 

 

Note: Before installing, please make sure the connection via USB cable between your PC 
and Mobile Computer is normally.  
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The program files are provided on the product CD:  

CP30 Application Generator CD Driver 

CP30_WM.exe Application Generator installer for CP30 Terminal 

AGCP30.msi Application Generator installer for your PC 

CP30 Application Generator (PC) 

AGCP30-xxxxxxx.lng This language file for AGCP30.exe 

AGCP30.exe 
The setup file for installing the applet to “\Program Files\CipherLab\Forge 
Application Generator” on your PC. 

AGCP30.ini A configuration settings log file. 

CP30 Application Generator (Mobile Computer) 

AG-Runtime.exe 

The setup file for installing the applet to “\Program Files\FORGE\” on the 
mobile computer.  

 The FORGE folder contains three files: AG-Runtime.exe, AG-Runtime.ini 
and CP30_WM.png 

 A shortcut icon to the AG applet is created and placed in: Start | AG 
Runtime. 

AG-Runtime.ini A configuration settings log file. 

CP30_WM.png A specific icon .png file for AG-Runtime. 
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HOW IT WORKS 

Data collection mainly consists of three elements: input (scanning or key-in), data 
processing, and output (updating database). FORGE Application Generator for CP30 
Mobile Computers is specifically designed to deal with the sequences of data processing 
inside the mobile computers.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: The generated *.A30 template file of PC will be saved to the default root \Program 
Files\CipherLab\Forge Application Generator.  

 
 

Run AG program on 
desktop computer - 
AGCP30.exe 

Copy the template file 
to mobile computer - 
*.A30 

Run FORGE application 
on the mobile computer 
– AG-Runtime.exe 

Form 

Menu 

Lookup 

Barcode 

Settings 

File 

Utilities 

About 

Run 

Open 

Import 

Export 

Exit 

Browse 

Delete 

Settings 
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GETTING STARTED 

Let’s take the example of CP30 Application Generator. 

1) Run AGCP30.exe on your computer. The miniature image of CP30 pops up. 

2) Right-click freely on the CP30 image.  

The Command Menu appears as shown below. 

 

3) Select [Edit] to start with a new or the latest application template. 

4) In Application Generator Configuration screen, you can click [OK] to close the editing 
window upon completion or click [Cancel] to end editing without save.  

5) Select [Save] or [Save As] to save the current editing template to file (*.A30).  

6) Copy the template file (*.A30) to the mobile computer via ActiveSync. 

7) Run the program AG-Runtime.exe on the mobile computer. 

8) Tap [Menu | File | Open] to use the copied application template (*.A30). 

9) Tap [Menu | File | Import] to import lookup file(s) if necessary. 

10) Tap [Run] on the soft key bar to start with your data collection task. 
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COMMAND MENU 

When the Command Menu first appears, it displays the following commands. 

 

Command Action... 

New To create a new application template. 

Open To open an existing application template. File path needs to be specified. 

Save To save the current editing template. 

Save As To save the current editing template to a new file. 

Edit To edit a new or the latest application template. 

Preferences To configure the language settings, application property and load action. 

About... To show information about the Application Generator.  

Exit To close the Application Generator. 

RECENT FILE LIST 

If you ever saved a template, it will be displayed in the Command Menu as well. Up to 4 
recent template files are listed for quick access. 

 

 The first file on the recent file list is the latest template you work on. If you 
accidentally clicked the Close button or [OK] of the template, simply click the Edit 
command to re-open it. 
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 You may click any of the four saved files to open the template for editing. The opened 
file will then be placed on top of the list. 

PREFERENCES 

 

 Auto-preload the last editing file. 

You may select the check box so that the last editing file will be loaded upon running 
the AG program on the desktop computer. 

 Always on top. 

You may select the check box so that the AG program always remains on top of all 
other windows on the desktop. 

 Language 

If there is any language file (*.lng) saved in the same folder where the AG program 
is, a drop-down menu will be available. Then you will be able to select a preferred 
language for the GUI of your program. 
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APPLICATION TEMPLATE 

To work on a new or existing application template, click the New, Open, or Edit 
command. An application template is composed of five tabs; each is a property page for 
custom configurations. 

 

Property Pages 

Form Forms are used to show information and allow for data input, which may be placed 
under a user menu, e.g. Main Menu > (Menu 1) > Form 1. 

Menu Menus are used to provide multi-level options, which may be placed under the 
main menu, e.g. Main Menu > Menu 1 > (Menu 2) > Form 1. 

Lookup Data of forms may make reference to one or up to 5 lookup files. You need to 
specify the data format of a lookup file.  

Barcode You may configure symbologies and barcode parameters. 

Settings You may configure program sequences and system settings so that they will take 
effect when initialization is done on the mobile computer. 

When you have completed all the configuration, copy the application template file 
(*.A30) to the mobile computer and open it. The submenus will become available now. If 
no lookup files are defined in both the Form and Lookup tabs, the associated options will 
become unavailable, as shown below. 
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Warning: On the Barcode tab of the AG program, you must select the correct barcode 
reader even though no modification is made to its settings. Otherwise, a 
warning dialog box is displayed to remind you of “wrong reader type” after 
opening the template file on the mobile computer. Then, you may choose to 
close the application directly or use the default setting to initialize the barcode 
reader.                
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A form is a data collection template with input prompts. Data will be kept as a 
transaction record after the user completes all the input fields (lines) of a form. Then, it 
can be saved in a data file, added to its lookup database, etc.  

 Each form allows at most twelve input fields (12 lines).  

 Twenty different forms can be defined. 

The attributes on this property page are explained in detail as follows. 

 

Note: Before scanning data, please go to Barcode tab to set the Barcode Reader type 
firstly. The wrong selection of Barcode Reader type will display “Wrong Reader 
Type!!” information on your mobile computer AG Utility.  

 

Chapter 1 
FORM 
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1.1 ID 

Select an ID for the current form you work on. Usually start with “form 1”. 

 form 1 ~ 20 
 

1.2 KEY FIELD 

By default, data is to be saved to a sequential data file (by “form”). However, you may 
select a key field as the index so that data will be saved by index and a quick search is 
allowed when browsing data. Refer to Menu > Utilities > Browse in Appendix I – 
Demonstration on Mobile Computers. 

 Select Save or Save & update in 1.6 Record. 

 This feature can be used together with the “Only read data once” feature, which is 
normally applied to prevent any repeated reading of the same barcode.  

Record Key Field Advanced > “Only read data once” 

None Regardless of this setting, data will be saved to a sequential 
file. 

Save 

Save & 
update Any (line 

1~12) 
 If “Only read data once” is enabled, any reading of the 
same barcode will be rejected. A warning message will be 
displayed on the mobile computer to indicate “Data 
duplicated!” 

 If “Only read data once” is disabled, the reading of the 
same barcode will be accepted but only the last one is 
saved. A message will be displayed on the mobile 
computer to indicate “Data updated!” 
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1.3 ESC 

Select a form or menu that will be displayed when you press the [ESC] key on the 
mobile computer.  

 main 

 form 1 ~ 20 

 menu 1 ~ 10 

Note: Normally, the [ESC] key is used to return to a previous form or menu. 

1.4 NEXT 

Select a form or menu that will be displayed when the last input field of the current form 
has been completed. 

 main 

 form 1 ~ 20 

 menu 1 ~ 10 

This function is invoked by sending the key value of [Enter] when you finish with the 
last input field. And, the setting of Input Source decides the way to produce the key 
value of [Enter]. 

Input Source of the last line Operation 

Reader In 1.15 Properties, Auto ENTER for barcode input must be 
configured as “Scan + ENTER”. 

Keypad Press the [Enter] key on the mobile computer. 

1.5 LOOKUP (FILE) 

A lookup file is a database. Select whether or not a lookup file is associated with the 
form. 

If a lookup file is used, its data format must be defined on the Lookup property page, 
especially the number of fields and length of each field. 

On this property page, related settings must be configured.  

 1.9 Data Type  

 1.14 Lookup (Field) / Variables  

Note: The associated lookup file(s) must be imported to the mobile computer. 
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1.6 RECORD 

Select which action to take as soon as the input fields of a form have been completed. 

Options Action... 

save To save the record to a data file. 

 Refer to the "Key Field" and "Advanced" settings. 

update lookup To update the lookup file associated with the form. 

save & update To save the record to a data file and update the lookup file. 

 Refer to the "Key Field" and "Advanced" settings. 

pass down To pass down data to the next form or menu without saving. 

Note: If data is to be saved in a data file, the default export file name can be changed in 
the “Advanced” setting. 

1.6.1 EXPORT FILES 

Refer to File Menu > Export Files in Appendix I – Demonstration on Mobile Computers. 
Based on the selected option of Record, you can export a data file (by “form”) or lookup 
file, or even merge them to a new file. 

 Data file:  

This is available only when you have selected “Save” or “Save & update” for Record. 
Refer to 1.2 Key Field about how to make use of an index. The default file name is 
“Form 01”. 

 Lookup file:  

This is available only when you have specified a lookup file in use. The default file 
name is “1st lookup file”. 

1.6.2 MANIPULATE DATA 

Refer to Utilities Menu in Appendix I – Demonstration on Mobile Computers. 
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1.7 TIME STAMP 

This feature actually includes Date and Time stamp. It may be helpful in analyzing data 
when the date and time information is joined in each record. 

 

1.7.1 STAMP POSITION 

Decide whether or not to enable the stamp function and include the date/time 
information, either to the beginning or to the end of a record. 

1.7.2 DATE/TIME FORMAT 

Select the format of the Date and Time stamp. To stop the use of either stamp, clear all 
the associated settings. 
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1.8 ADVANCED 

Here provides additional settings associated with the “Key Field” and “Record” features. 

 

1.8.1 ONLY READ DATA ONCE 

When the “Only read data once” feature is enabled, a warning message “Data 
duplicated!” is displayed on the mobile computer if the entry of input data already exists. 

Note: To enable the “Only read data once” functionality, you must specify the key field. 

1.8.2 CHANGE EXPORT NAME 

By default, data is to be saved to a sequential data file (by “form”). Change the file name 
if necessary. 

1.8.3 AUTO EXPORT… 

If “Auto export transaction table when close application” is enabled, the data file will be 
exported automatically upon closing the application. Choose the save mode to decide 
whether the data file will overwrite or append to the existing file. 

1.8.4 ENABLE AUTOMATIC DATA DELETION 

When Data Deletion is set to “Automatic”, a data file is to be deleted once it has been 
exported to the host by default. You may disable the Automatic Data Deletion feature to 
keep the data file. 
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1.8.5 ENABLE MSQI FUNCTION 

This function is used to multiple classifies with some same items manage. When the 
Multiple Scan Quantity Incrementing (MSQI) function is enabled, the Data type will be 
locked except for LooKup and nil items. Only Line#1 and #2 will be processed. And the 
form is set to be processed again and again until you tap the [Save] key on the soft key 
bar to save the data. 

 Line 1 is set to “text” for data type.  

 Line 2 is set to “MSQI” for data type. By default, the initial value is “0” that means 
the field of scan data is beginning from “1”; you may specify a value instead.  
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If a lookup file is specified in use, you may specify to import more information (line #3~) 
lookup selected item and display it on the mobile computer. 

 

 
 
 
 
 
 
 
 
 
 
 
 

The process designed in Form 01, as shown above, will repeat as long as you are 
scanning barcodes. 

 When you keep scanning the same barcode, it will accumulate the value for “Qty” 
field by add one for each scanning. (The example as shown above for MSQI initial 
vale is set to “1”. Therefore, when you scan one data as same as “Item” No., the 
“Qty” will be changed to as “2”, scan again as “3” and so on.  
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 When you scan a different barcode, it starts all over again with accumulating the 
quantity of this new item. Data for the previous item will be saved as a transaction 
record! (The example as below, the MSQI initial vale is set to “1”.) 

Run AG-Runtime. → Scan 4710421064357 barcode two times, Qty will show “3”. 

   →   

Scan another barcode as 47113282 one time, Qty will show “2” (MSQI initial vale is 
“1”). 
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Below is the process flow explaining how MSQI function works. 

1) Scan a barcode for an item. (line #1) 

 

2) The lookup value will be displayed as the initial value. (line #2 for example initial 
value is “1” add scan one time say “2”.) 

 

Note: If no lookup file is specified in use, the pre-defined initial value will be displayed.           
If any lookup file is specified in use as field1~12, the Qty initial value will disable. 
The output values will depend on the specified lookup .txt file. 
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3) Scan the barcode again, and it will accumulate the value by 1, say “3”.  

 

4) You may keep scanning barcodes for different items. Repeat step 2 and step 3.  

Each different scan item will save automatically. To end the scanning, remember to 
tap “Save” on the soft key bar. Otherwise, the scanned data will be lost. 

5) Tap [Save] on the soft key bar to save scanning data and tap [X] on the soft key 
bar or press [ESC] to end the scanning task.  

6) A dialog box appears requesting you to input a track number as a scanned data 
separation. Enter a number if necessary; otherwise, tap [OK] to skip and close the 
dialog box. 
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Alternatively, if you have a large number of the same item, you may manually input the 
quantity, say “30”. It will override the previous scanning of this item. Tap [Save]. Data 
for the quantity field saved with this transaction record is “30”. 

  

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Start with initial scanning. When 
the MSQI initial value is “1”.

Scan the same barcode to accumulate 
the quantity. 

Manually input a value to override 
the previous scanning. 
Tap [Save] to save data. 

Tap [X] or press [ESC] to end the 
scanning task. 

 

Input track no. if 
necessary. 
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Tap Menu│Utilities│Browse to browse data, you will see records as shown below. The 
last one is for the track number.        
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1.9 DATA TYPE 

Before the beginning of below example, make a lookup file firstly and copy it to your 
mobile phone for AG-Runtime utility. Tap Menu│Utilities│Import to import lookup .txt 
file. 

Make a lookup file as below. → Run AG-Runtime utility to import lookup .txt file. 

    

After you importing specified lookup .txt file successfully, the screen will pop-up 
“Database import OK!!” information. If the screen pop-up you “Format of this lookup file 
is incorrect!” please check the Lookup related settings on Application Generator utility. 
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Specify the data type line by line to address your application requirements. Take the 
following for example. 
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The associated settings for each data type are marked in the table below. 
 

Data Type Prompt Input Source Length Lookup Properties 

 on-screen saved in record  Min / Max Field More... 

nil       

text 9  9 9 9 9 

integer 9  9 9 9 9 

real 9  9 9 9 9 

letter 9  9 9 9 9 

auto (+/-) 9  9 9 9 9 

boolean 9  9  9 9 

lookup 9 User-definable   9 9 

fixed data 9 9    9 

prompt 9      

counter 9      

pass down 9      

extension       

pause 9      

alphanumeric 9  9 9 9 9 

image 9   9 9 9 

large data 9 9  9 9 9 

read from 2D 9 9  9 9 9 

1.9.1 NIL 

No data input is allowed.  

 This is the default setting. There will be single line spacing on the mobile computer 
screen. 

 When the data type of the previous line is “image”, you may need to reserve enough 
space for displaying the image. 

1.9.2 TEXT 

ASCII character – any character is acceptable. For example, $1a2b3c=-*/… 
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1.9.3 LETTER 

Alphabetic character – any letter is acceptable, capital or small (Aa ~ Zz). 

1.9.4 ALPHAMERIC 

A combination choice of alphabetic (1.9.3) and numeric (1.9.5); any alphabet or 
number is acceptable. For example, ABC123xyz 

1.9.5 INTEGER 

Whole number - any number is acceptable, such as … -2, -1, 0, 1, 2 … 

 When integer or real is selected along with lookup field specified, the lookup 
specified value will be first displayed in the input field on the mobile computer screen. 
Then, data input or change is allowed.  

 
 

 

Lookup Value Input Value
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LOOKUP (FIELD) – NO ARITHMETIC SIGN 

For example, if you select “Save & Update” for Record, the input value will overwrite the 
lookup value. No arithmetic operations are performed 

 Menu > Utilities > Browse (Data) > select “Form 01”: the value of the entry is 103 

 Menu > Utilities > Browse (Data) > select “1st lookup file”: the value of the entry is 
103 

LOOKUP (FIELD) – ARITHMETIC SIGN “+” 

For example, if you select “Save & Update” for Record, it will automatically add the input 
value to the lookup specified value. (Lookup item is set to “+” field X.) 

 Menu > Utilities > Browse (Data) > select “Form 01”: the value of the entry is 103 

 Menu > Utilities > Browse (Data) > select “1st lookup file”: the value of the entry is 
203 (initial value 100+ input data 103=203.) 

 

LOOKUP (FIELD) – ARITHMETIC SIGN “−” 

For example, if you select “Save & Update” for Record, it will automatically subtract the 
input value to the lookup specified value. (Lookup item is set to “-” field X.) 

 Menu > Utilities > Browse (Data) > select “Form 01”: the value of the entry is -103 

 Menu > Utilities > Browse (Data) > select “1st lookup file”: the value of the entry is 
-3 (initial value 100-input data 103=-3) 

1.9.6 REAL 

Real number – any number with a decimal representation is acceptable, rational or 
irrational. For example, 4.56 
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1.9.7 AUTO (+/-) 

Any Integer number is acceptable. For example, 123 

 This is similar to data type integer, except that the lookup specified value whether is 
displayed or not before the input field. There may be an arithmetic sign (+, -) in front 
of the input field, which depends on the setting of the Lookup field on Application 
Generator configuration (PC).  

LOOKUP (FIELD) – NO ARITHMETIC SIGN 

For example, if you select “Save & Update” for Record, the input value will simply 
overwrite the lookup specified value. No arithmetic operations are performed. 

 Menu > Utilities > Browse (Data) > select “Form 01”: the value of the entry is 8 

 Menu > Utilities > Browse (Data) > select “1st lookup file”: the value of the entry is 8 

 

    
 

Input ValueLookup Value 
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LOOKUP (FIELD) – ARITHMETIC SIGN “+” 

For example, if you select “Save & Update” for Record, it will automatically add the input 
value to the lookup specified value.  

 Menu > Utilities > Browse (Data) > select “Form 01”: the value of the entry is 5 

 Menu > Utilities > Browse (Data) > select “1st lookup file”: the value of the entry is 
105    

                        

      

 

 

 

 

 

Input ValueLookup Value 
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LOOKUP (FIELD) – ARITHMETIC SIGN “−” 

For example, if you select “Save & Update” for Record, it will automatically subtract the 
input value to the lookup specified value. 

 Menu > Utilities > Browse (Data) > select “Form 01”: the value of the entry is -7 

 Menu > Utilities > Browse (Data) > select “1st lookup file”: the value of the entry is 
93 

 

    
 

 

 

 

 

 

Input ValueLookup Value 



36 

 

FORGE CP30 Application Generator User Guide  

 

1.9.8 EXTENSION 

No data input is allowed. 
 

 The line will be reserved as an “extension” of the previous line so that the whole input 
data can be displayed on the mobile computer screen. 

 
 

 

 

 

 

 

 

 

 
 

Note: The number of extension lines depends on the maximum length of your data and 
how many characters can be displayed per line of an input field. 
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1.9.9 PASS DOWN 

No data input is allowed. 

 Data of this line may be imported from a previous form, of which the setting of 
Record is specified as “pass down”. The Data type of present form should at least 
one as “pass down”. When one line is not enough for displaying the inherited 
contents, set its following line(s) to be an “extension”.  

Note: This data type is used to combine input data of previous forms so that they can be 
saved as one record. 

 

 

    

Show the pass 
down input data 

Lookup & Input 
Values 

For pass down 
function, at 
least should be 
an input data. 
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1.9.10 BOOLEAN 

Only one of these sets of values are acceptable – “0 or 1”, “Y or N” and “T or F”. 

 If you input a value other than the above ones, a message will be displayed on the 
mobile computer to indicate "Incorrect data type!" 

  →    

1.9.11 LOOKUP 

No data input is allowed. 

 When data of a previous input field is found matching with the “key field” of a lookup 
file, data of this input field will be imported from its associated lookup field. This field 
will be displayed in grey on the mobile computer. 

 By default, the imported data will not be saved in the transaction record. Click the 
[more] button and select Save field data in its associated Properties as shown 
below. 

 

Input the 
Boolean Value 
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Note: The lookup value is imported for reference. No change is allowed. 
 

1.9.12 FIXED DATA 

No data input is allowed.  

 The prompt string will be saved as part of the transaction record. 

1.9.13 PROMPT 

No data input is allowed.  

 The prompt string will not be saved. 

1.9.14 PAUSE 

No data input is allowed.  
 
 

 The prompt string will not be saved. However, it will be displayed on the mobile 
computer as a message to catch your attention. 

 

1.9.15 COUNTER 

No data input is allowed.  

 The current record count will be displayed in eight digits, starting from 00000000. 
Refer to 5.4.3 Entry Options.  
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1.9.16 IMAGE 

Only image data is allowed. The supported image file formats include BMP, JPEG, PNG, 
and GIF. 
 

 The prompt string and the file path to an image will both be saved in the transaction 
record. Click the [more] button and select Edit file path to give a full path to an 
image file in the associated Properties dialog box as shown below. You may specify a 
default file path to an image file and change it later while collecting data. 

Note: For CP30 mobile computer to capture an image, you must make sure that it is 
equipped with either a camera or reader. For the latter, the Barcode Reader 
setting on the Barcode tab must be enabled. If both camera and reader exist, it 
only allows using one capture utility for image capture.    

 

 

 

Select the check box to display 

 for the form. 
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 Reserve a number of lines (“nil” by default as shown below) to have enough space for 
displaying the image.  

 

      

Tap  to open an image or capture a new image. 

Warning: When “Edit file path” is selected, the file path to an image can be specified or 
edited. If the “Edit file path” is not selected, the file path will not allow to be 
edited just only for viewing Image. 

 

Tap this button to open 
an image file or 
capture a new image. When “Edit file path” 

is selected. 
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1.9.17 LARGE DATA 

This data type option is available only when you have selected 2D scan engine for use on 
the mobile computer. Refer to 4.1 Reader Type. 

 For each form, you can have only one field set to large data. 

 It allows up to 2048 characters to be collected via the 2D scan engine. 

 By default, the maximum field length is 160 characters, which requires manual 
adjustment for reading more and up to 2048 characters. 

 By default, the “Read partial barcode” setting is enabled and set to read from the 
start position “1” and maximum length “20”. It requires manual adjustment for 
reading more and up to 160 characters. For reading more than 160 characters, you 
need to disable the “Read partial barcode” setting. Refer to 1.15.2 Barcode Input. 

Note: The Variable/Field setting will become disabled when both of the requirements are 
deployed: (1) the maximum field length is over 160 characters, and (2) the “Read 
partial barcode” setting is disabled. 

1.9.18 READ FROM 2D 

This data type option is available only when the following requirements are deployed: (1) 
you have selected 2D scan engine for using on the mobile computer, and (2) one of its 
preceding Data type fields must be set to “Large data”. 

 For each form, after having set one field to “Large data”, you can set as many fields 
to “Read from 2D” as you need. 

 It allows extracting partial data, up to 160 characters, from the fields set to “Large 
data”. Refer to 1.15.2 Barcode Input. 
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1.10 PROMPT 

Specify a prompt string for a specific input field, if necessary. Maximum 30 characters 
are allowed. Due to the screen size, the length of the prompt string will affect the looking 
display on the screen – it may be a very narrow input box if the prompt string is too 
long, and therefore, it will not display the whole input data on the screen, even though a 
number of its following lines are set to “extension”. It is better not to exceed 12 
characters in browsing data because the prompt string is limited to 12 characters for 
displaying. 

Note: Unless the data type of a line is “fixed data”, a prompt string will not be saved in a 
transaction record. 

1.11 INPUT SOURCE 

Specify from which source data can be collected. 

 All 

 Reader 

 Keypad 

Upon completion of one input field, it is necessary to press the [Enter] key on the 
mobile computer. Then it will move either to the next input field, or to the next form or 
menu.  
 

When the Input Source is specified to “reader” only, you need to enable “Auto ENTER” for 
barcode input settings in 1.15 Properties. 
 

1.12 MINIMUM LENGTH 

Specify the minimum length of an input field.  

 If the input data is shorter than specified, it will be considered unacceptable. A 
warning message will be displayed to indicate “Data is too short!” 

1.13 MAXIMUM LENGTH 

Specify the maximum length of an input field. The value can be 160 at most.  

You can facilitate data input by showing input marks on the screen. In 1.15 Properties, 
select Show input mark. The number of input marks equals to the maximum length 
specified here. 
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 If the input data is longer than specified, it will be considered unacceptable.  

Input via Barcode Reader 

A warning message will be displayed to indicate “Data is too long!” 

Input via Keypad 

No warning message, however, you cannot input any more characters beyond the maximum 
length. 

1.14 LOOKUP (FIELD) / VARIABLES 

If there is no lookup file in use, this feature will be Variables. 

1.14.1 LOOKUP (FIELD) 

Refer to 1.5 Lookup (File). If a lookup file is in use, you need to specify the 
corresponding lookup field line by line. For each lookup file, there will be a key field. By 
default, the “key field” is Field #1. When an input field makes reference to the key field 
and its input data is matched, data for its specified input fields will be quoted to each 
corresponding lookup fields. 

 For those data types other than integer, real, and auto (+/-), see the options left 
below. 

 For data types integer, real, and auto (+/-), see the options right below. 

When an arithmetic sign (+, -) is prefixed to the lookup field, the input data will be 
added or subtracted from the lookup specified value. 

                                               

         
 

Lookup Field Lookup Field for data type: 
integer, 
real, 
auto (+/-) 
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1.14.2 VARIABLES 

Refer to 1.5 Lookup (File). If there is no lookup file in use, it will provide variables as 
shown below, which can be accessed by different forms.  

For example, you may specify set v1 for input field #1 of form 1, and its input data will 
be saved in the first character array. Specify get v1 for input field #3 of form 2, and the 
previous input data will be quoted and imported. If you specify get&set v1 for input field 
#3 of form 2, the previous input data will be imported and then updated. 
 

                                    

Variables
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1.15 PROPERTIES 

Specify field properties if necessary. 

 

1.15.1 FIELD DATA 

FIXED DATA LENGTH 

Select the check box. The data length will be fixed to the value specified here.  

 If the input data is longer, it will be truncated and saved to transaction record for the 
exported file only. When browsing data, it will remain intact on the screen. 

 If the input data is shorter, “Space” or “0” will be added in front of or to the end of 
the data based on either “Left” or “Right” alignment. 

Below are some examples. 

Fixed data length Alignment Input data Transaction record 

4 Left aligned / space 123456789 1234 

4 Right aligned / space 123456789 6789 

10 Left aligned / 0 7654321 7654321000 

10 Right aligned / 0 7654321 0007654321 
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INITIAL VALUE OR TEXT 

Select the check box. An initial value or text, up to 10 characters, specified here will be 
shown in the input field.  

For example, it can be used to prompt an initial value for quantity. 

ADD PREFIX CODE 

Select the check box to prefix a code to the input data. Click the editing box next to it, 
and select one or more codes from the Grid Control (ASCII codes). For example, a dollar 
sign (“$”) can be added to the front of the data input for price. Only be showed to 
transaction record. 

ADD SUFFIX CODE 

Select the check box to suffix a code to the input data. Click the editing box next to it, 
and select one or more codes from the Grid Control (ASCII codes). Only be showed to 
transaction record. 

Instead of using delimiters in 5.2 Data Field Delimiter, you may use prefix and/or suffix 
codes to separate each entry of input data.  

Note: You may use prefix/suffix code to wrap the input data. The prefix/suffix code will 
be added to the exported file only. 

SHOW INPUT MARK 

Select the check box to show input marks, such as underline (_) or asterisk (*), which is 
to be replaced by input data.  

The number of input marks shown on the screen equals to the maximum length of data 
specified in 1.13 Maximum Length. 

DECIMAL PLACES 

A decimal place is the position of a digit to the right of a decimal point. When the data 
type is real, you may need to specify its decimal places.  

 By default, it is set variable to accept all real numbers.  

For example, 4 is selected for decimal places, however, there are only 2 decimal places 
in the input number, say “8.12”. To follow this rule, the system will save the input data 
as “8.1200”. If you try to input a number “8.12345” via the keypad, it will not allow the 
input of the fifth decimal digit. Only “8.1234” is considered acceptable and saved to file. 

If the barcode “8.12345” is scanned via the barcode reader, a warning message 
“Incorrect decimal input” will be displayed on the mobile computer, and the system will 
automatically clear the input data and wait for new entry. 
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1.15.2 BARCODE INPUT 

READ PARTIAL BARCODE 

By default, it will return the whole barcode that has been decoded. When the check box 
is selected, it will return partial barcode according to the settings of the start position and 
maximum length.  

Below are some examples. 

Start position Max. length Barcode scanned Transaction record 

2 10 9876543210 876543210 

2 3 9876543210 876 

CHECK LEADING CODE 

The leading code refers to the digit in the start position of a barcode.  

Select the check box to verify the barcode input. When the leading code is not matching, 
the barcode will be rejected. 

Below are some examples. 

Leading code Barcode scanned Transaction record 

9 9876543210 9876543210 

2 9876543210 (Discarded: code not matching) 

Read partial code + Check leading code: 

Start position Max. length Leading Code Barcode scanned Transaction record 

2 7 8 9876543210 8765432 

2 7 9 987654321 (Discarded) 

CHECK DIGIT VERIFICATION 

The check digit refers to the digit in the end of a barcode, as a one-digit derived 
checksum digit. Select the check box to verify the barcode input. You may apply different 
modulus 10 or 11 check digit as provided in the drop-down menu. When the check digit 
is not matching, the barcode will be rejected. 

AUTO ENTER 

Normally, it is necessary to press the [Enter] key on the mobile computer upon 
completion of one input field. Then, it will move either to the next input field, or to the 
next form/menu specified.  
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This function will automatically add a carriage return in front of or to the end of the 
barcode input. 

 For barcode scanning, it proves to be timesaving when Scan+ENTER is enabled. 

 For a typical application of continuous scanning, it is efficient by making use of 
ENTER+Scan.  

 

1.16 RESET 

Click this button to load the default settings. 

Note: The settings for the current form will be cleared once you click “RESET”. 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 



50 

 

FORGE CP30 Application Generator User Guide  
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A menu is a list of selection items. Up to ten different menus can be defined. 

Below are the settings for each field of a menu. 

 

 

IN THIS CHAPTER 

2.1 ID ........................................................................... 52 
2.2 ESC ......................................................................... 52 
2.3 Menu Caption............................................................ 52 
2.4 Item Name ............................................................... 52 
2.5 Next ........................................................................ 54 
2.6 Data ........................................................................ 54 
2.7 Reset ....................................................................... 55 

Chapter 2 
MENU 
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2 
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3 

6 

7 
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2.1 ID 

Select an ID for the current menu you work on. Usually start with “menu 1”. 

 menu 1 ~ 10 

2.2 ESC 

Select a form or menu that will be displayed when you press the [ESC] key on the 
mobile computer.  

 main 

 form 1 ~ 20 

 menu 1 ~ 10 

Note: Normally, the [ESC] key is used to return to a previous form or menu. 

2.3 MENU CAPTION 

Select the check box and specify a caption for the current menu if necessary. 

2.4 ITEM NAME 

Specify a name for each menu item. For example, you may specify “1.Goods In”、
“2.Goods Out” and “3.Stock” topic items (see below). 

 Tap Settings tab. 

 Select Program start from as menu1 or form1 depends on the Menu tab definition. 

 Tap Menu tab to set Item Name as below. 
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Specify “1.Goods In” (see left below) or “Goods In” (see right below) topic items of 
menu. The only difference is the Item No. will not be displayed on the screen in the 
latter. 

                     

Note: To display the menu items on your mobile computer, you have to tap the Settings 
tab to set the program start from as “menu1 or form1” depends on the 
definition of Menu tab. 

 

Enable Menu Caption 

Item Name Item Name 

Disable Menu Caption 
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2.5 NEXT 

Select the next form or menu that will be launched to display when tap a menu item. 

 main 

 form 1 ~ 20 

 menu 1 ~ 10 

This function can be activated by performing one of the following actions on the mobile 
computer – 

 Double-tap the desired menu item. 

 Press the [Up/Down] arrow keys to select a menu item, and then press [Enter]. 

2.6 DATA 

Specify how to proceed when a menu item has been selected. 

 Save caption – Save the menu caption to the transaction record as “Pass Down” data 
if this menu is running. 

 Save selected item – Save the selected menu item to the transaction record as “Pass 
Down” data if this menu applies. 
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 Save caption and selected item – Save both to the transaction record as “Pass Down” 
data. If the data is too long to be displayed in full, press the [Right Arrow] key on 
the keypad to view the rest of it if necessary. 

                         

Note: The selected option(s) will be passed down to an associated form or menu. 

2.7 RESET 

Click this button to load the default settings and the settings for the current menu will be 
cleared. 

Save selected item Save caption

Save caption & selected item

Press [Right Arrow] 
to view the rest 
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A lookup file is a database file created for information reference. Up to five lookup files 
can be defined. If settings on this property page are specified improperly, it may go 
wrong when an input field makes reference to its corresponding lookup field. 

If the default settings remain unchanged for the following items in the AG template file 
that has been copied to your mobile computer, [File > Import] and [File > Export] 
will be unavailable on the mobile computer. 

Besides this chapter, you may refer to the following sections for a whole understanding 
of all related settings: 

 1.5 Lookup (File)  

 1.9.11 Lookup (Data Type) 

 1.14 Lookup (Field) / Variables (Field) 

 

Chapter 3 
LOOKUP 
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IN THIS CHAPTER 

3.1 ID .......................................................................... 59 
3.2 Field Property............................................................ 59 
3.3 Number of Fields ....................................................... 59 
3.4 Data Type................................................................. 60 
3.5 Field Name ............................................................... 61 
3.6 (Max) Length ............................................................ 61 
3.7 Key Field .................................................................. 61 
3.8 Change Export Name.................................................. 62 
3.9 Auto Export Lookup Table When Close Application .......... 62 
3.10 Enable Automatic Data Deletion ................................. 62 
3.11 Action When the Format of Record Is Wrong ................ 62 
3.12 Action When the Input Data Has No Match................... 63 
3.13 Reset ..................................................................... 64 
 

Note: Before importing the Lookup AG template file on your mobile phone, you have to 
make the template file as a .txt file. The specified character numbers depend on 
the Lookup tab that can not exceed the Field Length.  
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3.1 ID  

Select a lookup file you want to define its settings. Up to 5 different lookup files can be 
specified. Usually start with the “1st lookup file”. 

3.2 FIELD PROPERTY 

Specify the settings of data field of the database (lookup file). 

3.2.1 FIXED LENGTH 

This is the default setting. Proceed to define related settings – 

 3.3 Number of Fields 

 3.6 (Max) Length 

3.2.2 DELIMITER 

You may use a delimiter (ASCII code) to separate the data fields. Proceed to define 
related settings –  

 3.3 Number of Fields 

 3.6 (Max) Length 

If the maximum length of each field is set improperly, you will receive a warning 
message in the import process. You may fail to import the lookup file, which depends on 
the action specified when the data format is wrong. Refer to the settings of 3.11 Action 
When the Format of Record Is Wrong. 

3.3 NUMBER OF FIELDS 

It must at least cover the referred fields of the database (lookup file). Refer to 1.14 
Lookup (Field) / Variables. 
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3.4 DATA TYPE 

A newly-added feature to help you verify whether the lookup file you are importing is 
correct or not. Be careful with the data type you set to each of the lookup field. If data in 
the lookup file is not as described, it may fail to import the lookup file and display a 
warning message. Refer to 1.9 Data Type for details on each data type and 3.11 Action 
When the Format of Record Is Wrong. 

 text 

 integer 

 real 

 letter 

 boolean 

 image — same as “text”, full file path is required, such as “\My Pictures\battery.jpg”.  

While browsing data, tap  to view image. It allows opening another image file or 
capturing a new image. 

 

  →   
 

text text integer image

Select another image file, 
or capture an image.  
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3.5 FIELD NAME 

Specify a name for each lookup field, which will be displayed on the mobile computer to 
facilitate data editing under [Utilities > Browse Data> Lookup File]. 

                     

3.6 (MAX) LENGTH 

 When the field property is set to Fixed Length, specify the length for each referred 
data field. 

 When the field property is set to Delimiter, specify the maximum length for each 
referred data field. 

 

Note: If a delimiter is used to separate data fields, any improper Max length value would 
cause wrong data format. 

 

3.7 KEY FIELD 

The import of data depends on the key field. Select your key field so that an index file 
can be created for the database (lookup file), and therefore enable searching by key field 
when you browse the lookup file.  

Refer to Utilities Menu > Browse in Appendix I – Demonstration on Mobile Computers. 
 

 When a form makes reference to a lookup file, there must be one input field 
associated with the key field of the database (lookup file). When the Key field input 
value (Field name) is matched to corresponding field of a lookup file, other input 
fields specified in lookup file will be bring up to relative fields. 

If no matching, refer to 3.12 Action When the Input Data Has No Match. 

Field Name 
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3.8 CHANGE EXPORT NAME 

If you have specified a lookup file in use, you can export it or even merge it with a data 
file. The default file name is “1st lookup file”. 

Note: The new name of a lookup file cannot be identical to that of the original file; 
otherwise, it will overwrite the original file! 

3.9 AUTO EXPORT LOOKUP TABLE WHEN CLOSE APPLICATION 

If a lookup file is in use and “Auto export lookup table when close application” is enabled, 
the lookup table will be exported automatically upon closing the application. Choose the 
Save Mode to decide whether the lookup table will overwrite or append to the existing 
table. 

3.10 ENABLE AUTOMATIC DATA DELETION 

When Data Deletion is set to “Automatic”, a lookup file is to be deleted once it has been 
exported to the host by default. You may disable the Automatic Data Deletion feature to 
keep the lookup file. 

3.11 ACTION WHEN THE FORMAT OF RECORD IS WRONG 

This applies to Delimiter, when a delimiter is used to separate data fields of the lookup 
file. It provides several options to handle wrong data format when you import the lookup 
file. 

3.11.1 STOP THE IMPORT PROCESS 

When wrong data format is encountered, a warning message will be displayed on the 
mobile computer. The import process is stopped then. You will need to correct the data 
format, for example, remove an empty record (line) at the end of a file. Then, import the 
lookup file again. 
 

3.11.2 TRUNCATE/REFORMAT THE RECORD 

When wrong data format is encountered, it will automatically truncate or reformat the 
lookup file in the import process. For example, the additional fields of a record will be left 
out. 

3.11.3 SKIP THE RECORD 

When wrong data format is encountered, it will automatically skip the record. 
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3.12 ACTION WHEN THE INPUT DATA HAS NO MATCH 

Choose the appropriate action to take when the input data does not match that of the 
key field. 

3.12.1 CONTINUE 

The program will allow data input to proceed without showing any message.  

 Data can only be saved in a data file if you have selected save or save & update in 
1.6 Record. 

 

3.12.2 SHOW WARNING MESSAGE 

A warning message “Data is not found!” is displayed on the mobile computer. If the Max 
length of Field is set to 10 on Barcode tab, the input value is “1234567891231” total for 
13 characters, 13> 10 the warning will appear as below. 

 Tap [OK] to close the message box. You will need to clear the input data manually.  

 

3.12.3 INSERT TO LOOKUP FILE 

The program will allow data input to proceed without showing any message. 

 Data will be inserted to the target lookup file if you have selected update lookup or 
save & update on Form tab in 1.6 Record. 
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3.12.4 SHOW WARNING MESSAGE & INSERT 

A warning message “Data is not found!” is displayed on the mobile computer. 

 It will resume to data input. Data will be inserted to the target lookup file if you have 
selected update lookup or save & update in 1.6 Record. 

 

3.12.5 CLEAR THE SCREEN 

The program will automatically clear the input data and wait for new entry. 

3.12.6 SHOW WARNING & CLEAR SCREEN 

A warning message “Data is not found!” is displayed on the mobile computer. 

 It will automatically clear the input data and wait for new entry. 

  →   
 

3.13 RESET 

Click this button to load the default settings. 

Note: The settings for the current lookup file will be cleared. 

 
 



  65 

 

 

According to the requirements of a specific application, you may enable or disable any of 
the barcode symbologies and configure the associated parameters.  

Supported barcodes depend on the scan engine integrated on the mobile computer. 

 

 

IN THIS CHAPTER 

4.1 Reader Type ............................................................. 66 
4.2 Reader Settings......................................................... 69 
4.3 Barcode & Parameters ................................................ 69 
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4.1 READER TYPE 

Depending on the module equipped on your mobile computer, the following reader types 
are supported –  

Scan Engine ID 

1D  Laser Reader SE955I, SE955E 

2D  2D Reader SE4500 WITH 
PL4507 

Note: You cannot have 1D+2D scan engines installed on the mobile computer because 
they are both barcode readers! 

4.1.1 BARCODE READER 

Select a reader type that matches the hardware configuration of your mobile computer.  

The associated barcode parameters will be displayed accordingly. If there is a More 
button next to the barcode symbology listed, advanced settings are available. 

Note: In order to initialize the barcode reader, you must select the correct reader type 
when you first configure a template file. Otherwise, a message “Wrong reader 
type!” will be displayed on the mobile computer after you opening the template 
file. 

SYMBOLOGIES SUPPORTED 

Varying by the scan engine installed, the supported symbologies or tag types are listed 
below. For details on configuring associated settings, please refer to each Appendix 
separately. 
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Symbology Laser 2D 

Codabar  9 9 

Code 11  9 9 

Code 93  9 9 

Composite Code 8 9 

MSI  9 9 

Postal Codes  8 9 

Industrial 25  9 9 

Misc.  9 9 

Interleaved 
25 

Convert to EAN-13 9 9 

Matrix 25  8 9 

Macro PDF  8 9 

Code 128 9 9 

GS1-128 (EAN-128) 9 9 

Code 128 

ISBT 128 9 9 

Industrial 25 (Discrete 25) 9 9 

Interleaved 25 9 9 

Matrix 25 8 9  

Code 2 of 5 

Chinese 25 9 9 

Code 39 9 9 

Trioptic Code 39 9 9 

Code 3 of 9 

Italian Pharmacode  

(Code 32) 

9 9 

EAN-8 9 9 

EAN-13 9 9 

Bookland EAN (ISBN) 9 9 

UPC-E0 9 9 

UPC-E1 9 9 

EAN/UPC 

UPC-A 9 9 

GS1 DataBar Omnidirectional  

(RSS-14) 

9 9 

GS1 DataBar Truncated 9 9 

GS1 DataBar Stacked 9 9 

GS1 DataBar 
(RSS) 

GS1 DataBar Stacked Omnidirectional 9 9 
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GS1 DataBar Limited  

(RSS Limited) 

9 9 

GS1 DataBar Expanded  

(RSS Expanded) 

9 9  

GS1 DataBar Expanded Stacked 9 9 

PDF417 8 9 

MicroPDF417 8 9 

Data Matrix 8 9 

Maxicode 8 9 

QR Code 8 9 

MicroQR 8 9  

2D 
Symbologies 

Aztec 8 9 

4.1.2 RESET 

Tap [Reset] to load the default settings. This applies to the following –  

 4.1 Reader Type 

 4.2 Reader Settings 

 4.3 Barcode & Parameters 

Note: The current settings will be cleared. 
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4.2 READER SETTINGS 

Refer to the reader settings table in related appendixes. 

4.3 BARCODE & PARAMETERS 

Refer to the symbology settings table in related appendixes.  

Scan Engine Reference 

Laser (SE955) Laser (SE955) 

2D Imager (SE4500 with PL4507) 2D IMAGER (SE4500) 
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On this property page, basic settings for the application program can be changed. 

 

 

IN THIS CHAPTER 

5.1 Program Start From ................................................... 72 
5.2 Data Field Delimiter ................................................... 72 
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5.6 Reset ....................................................................... 77 
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5.1 PROGRAM START FROM 

Decide where the application program starts as soon as you tap [Run] on the soft key 
bar on the mobile computer. 

 form 1 

 menu 1 

5.2 DATA FIELD DELIMITER 

The input data will be saved as transaction records. Specify the delimiters used to 
separate data fields, either in ASCII code or text. It allows using up to two different 
delimiters. 

Type the ASCII code for a delimiter and its corresponding character will be shown 
automatically, and vice versa. 

5.3 CAMERA INITIAL SETTINGS 

If a camera and 2D reader both exist, it only allows using the camera for image capture. 

Camera Settings Options 

Resolution By default, 1600 by 1200 pixels resolution is in use.  

 640 by 480 pixels resolution is supported. 

 1280 by 960 pixels resolution is supported. 

Capture Settings Options 

Default image store By default, the captured image is stored under the directory “\My 
Documents”. Specify a file name, and the full path name will be saved 
to the transaction record. 

Auto file name By default, the captured image is saved to a user-specified filename. 

When enabled, the captured image will be saved to a filename 
following the automatic naming rule explained below. 

File Title Specify a string prefixed to the filename. It allows up to 5 characters. 
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Using default naming rule  When enabled, the format of automatic filename is 
xxxxxfaabbccccc.jpg (or .bmp), where 

 “xxxxx” is the file title specified above. 

 “f” can be the capital letter F for Form, or L for Lookup. 

 “aa” indicates in which Form (or Lookup) the image  data is 
saved. 

 “bb” indicates in which “Field” of Form (or Lookup) the     image 
data is for. 

 “ccccc” stands for a 5-digit serial number starting from “00001”.  

 When disabled, the format of automatic filename is 
xxxxxccccc.jpg (or .bmp), where 

 “xxxxx” is the file title specified above. 

 “ccccc” stands for a 5-digit serial number starting from “00001”. 

5.4 SYSTEM INITIAL SETTINGS 

System Settings Default Value Remarks 

1. Auto-preload the last template file 
(.A30) 

No Select the check box of “Auto run the 
application (template)” if necessary. 

2. Data Deletion Manual  

3. Entry Options Show count Stay on the LCD for 600 ms 

4. Vibrator Duration Off  

5. Default export store \My Documents  

6. Always delete all database in the   
device when open the template file 

Disabled  

5.4.1 AUTO-PRELOAD THE LAST TEMPLATE FILE 

You may select to automatically pre-load the last template file and the imported lookup 
file(s) upon running the AG-Runtime on the mobile computer. 

 By default, you need to tap [Menu > File > Open] to open a template file. 

Template File FORGE AG Runtime 

*.A30 AGCP30.exe 
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5.4.2 DATA DELETION 

You may decide whether to delete data after exporting to the host. By default, it is set to 
“Manual”, which means you have to decide whether or not to delete data upon 
completion of export. If you decide not to delete data, you can always tap [Menu > 
Utilities > Delete] to delete at a later time. 

You may select “Automatic” to automatically delete data upon completion of export. The 
data file (by “form”) or lookup file with its setting to automatic data deletion is enabled, 
will be deleted. If so, the exported data will not be available any more when you tap the 
following submenus – 

 [Menu > File > Export] 

 [Menu > Utilities > Browse] 

 [Menu > Utilities > Delete] 

If neither of the above two options are desired, select “No” to skip data deletion upon 
completion of export. The data file(s) and lookup file(s) will be kept on the mobile 
computer after exporting to the host. However, you can always tap [Menu > Utilities > 
Delete] to delete at a later time. 

5.4.3 ENTRY OPTIONS 

You may specify whether or not to display more information, either the record count 
(Show count) or the record preview (Show record), before proceeding to the next entry. 
When selecting “Show count” or “Show record”, you will need to specify how long it will 
be displayed on the screen. Time-out is specified in the range of 1~99, in units of 100 
milliseconds. 

 By default, the record count will be displayed on the mobile computer screen for 600 
milliseconds as soon as an entry is completed. Refer to 1.9.15 Counter. 

5.4.4 VIBRATOR DURATION 

You may specify whether or not to turn on the vibrator to warn you of a specific event. 

5.4.5 DEFAULT EXPORT STORE 

You may specify the storage directory which the export file will be saved to. 

 By default, the default export storage directory is “\My Documents”. 

5.4.6 ALWAYS DELETE ALL DATABASE …  

If this item is selected, then the database will be deleted every time you open the 
template file. It means the database will be the new one and there will be no records in 
the database every time you open this file. 

 
 



  75 

 

 Chapter 5  Settings 

 

5.5 SECURITY 

For security concerns, you may specify a password and select the check box of one or 
more tasks that need security checking. 

 By default, no password is required for the listed tasks. 

 A password can be up to 10 alphanumeric characters. 

Note: The password is case-sensitive. 

If any task is selected and provided with a password, you will not be allowed to enter a 
submenu on the mobile computer without the password. 

Security Options Password-protected Settings 

Open Menu > File > Open 

 

 

 

 

Import Menu > File > Import 

 

 

 

 

Export Menu > File > Export 
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Security Options Password-protected Settings 

Edit Data Utilities > Browse 

 

 

 

 

Delete Data Utilities > Delete 

 

 

 

 

Settings Utilities > Settings  

 

 

 

 
 

Auto-preload Utilities > Settings > Auto-preload 

 

Data Deletion Utilities > Settings > Data Deletion 

 

Entry Options Utilities > Settings > Entry Options 

 

Vibrator Duration Utilities > Settings > Vibrator 
Duration 

 

Security 
checking 

Utilities > Settings > Security 

Camera 
Properties 

Utilities > Settings > Camera 
Properties  

(hardware dependent) 

 
 

Note: (1) 2D Image Capture option is only available when the Image Capture setting on 
the Barcode tab is enabled for 2D reader.                               
(2) Camera Properties option is only available on mobile computer when equipped 
with a camera. If a camera and 2D reader both exist, it only allows using the 
camera for image capture. 
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5.6 RESET 

Tap this button to load the default settings. 

Note: The current settings will be cleared. 
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Let’s take the example of CP30 Application Generator. 

1) Run AGCP30.exe on your computer to configure application templates. 

2) Save the template file (*.A30) and copy it to the mobile computer via ActiveSync. 

3) Run AG-Runtime.exe on the mobile computer. 

     

4) Tap [Menu > File > Open] to use the application template (*.A30). 

5) Tap [Menu > File > Import] to import lookup file(s) if specified in the template file 
for use. 

6) Tap [Run] to start with your application. It may start from a menu or form. 

7) Tap [Menu > Utilities > Browse] to edit data collected. 

Tap [Menu > Utilities > Delete] to manually delete a data file or lookup file. 

Tap [Menu > Utilities > Settings] to change system settings directly. 

8) Tap [Menu > File > Export] if you wish to export a data file or lookup file. 
 

Appendix I 
DEMONSTRATION ON MOBILE COMPUTERS 



80 

 

FORGE CP30 Application Generator User Guide 

 

MAIN MENU (READER TEST) 

Run the program and the main menu is displayed as shown below.  

 

You can perform a reader test on sample barcodes if necessary. Refer to 4.1.1 Barcode 
Reader for associated settings. 

Note: The correct reader type must be selected when configuring your application 
template, even though you have not made any changes to it.  
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FILE MENU 

Refer to 5.5 Security. You may apply password-protection to these tasks.  

OPEN .A30 FILE 

You will need to open a *.A30 file first. The rest depends on the configuration of this 
template file.  

IMPORT LOOKUP FILES 

If you have associated a form to a lookup file, you will need to import the lookup file 
after opening the *.A30 file. Finally, run your application. 

    

1) Open a *.A30 template file specified a form on your computer.  

2) Import the corresponding .txt lookup file.  

3) Run the application. 

4) The Form or Menu combine with template file and lookup file will be displayed on the 
screen of your mobile phone.  

1 

2 

3

4 
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EXPORT FILES 

You can export a data file (by form) or lookup file, or even merge them to a new file. 
Refer to 1.6.1 Export files. 

  →   

Note: If the export file name is the same as of an existing file, the exported data will 
overwrite the original one. Otherwise, you may select “Append to file”. 

DATA FILES 

This is available only when you have selected Save or Save & update for Record.  

 The default file name is “Form xx”, start from Form 01.  

 The exported data file is a sequential file. 

 
                                                                                                        
 

Select to save by index 
if quick search is 
desired for data 
browsing. 
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 You may specify an automatic exporting function for a data file when closing the 
application and the save mode of the exporting. 

LOOKUP FILES 

This is available only when you have specified a lookup file in use.  

 The default file name is “xxx lookup file”, starting from 1st lookup file. 

 If “Auto export lookup table when close application” is enabled, the lookup table will 
be exported automatically upon closing the application. It either overwrites or 
appends to the existing table. 

  

 

 

 
 



84 

 

FORGE CP30 Application Generator User Guide 

 

NEW DATABASE 

Below are FORGE applications that support upgrading database. 

FORGE AG-Runtime Application Generator Version 

AGCP30.exe 0.00.0005 or later 

The “Open new A30 and delete old database??” pop-up information screen will be 
displayed when you have an old database in use.  

 

EXIT THE APPLICATION 

Choose [Menu > File > Exit] to end the application properly. 
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RUN THE APPLICATION 

If no lookup files are associated with your forms, run your application after opening the 
template file.  

Here is an example of starting from “menu 1”. 

     

 

 
 

1 

2

3 
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UTILITIES MENU 

Unless a task is password-protected, you can edit data, delete files, and change the 
system settings. Refer to 5.5 Security. 

 

BROWSE 

You can edit a data file or lookup file if necessary. 

   →   
 

Tap the button to view or 
change the image 
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Editing Toolbar 

 
First Record Go to the first record. 

 
Previous 
Record 

Go to the previous record. 

 
Next Record Go to the next record. 

 
Last Record Go to the last record. 

 
Update Update the current record if you have made changes to any field. 

 
Delete Delete the current record. 

 
Search Search in the saved data by form or lookup file. (only for full match; 

case-sensitive) 

 By “Form” – You must select the field that is the key field defined on 
the Form property page. 

 By “lookup file” – You must select the field that is defined as the “key 
field” on the Lookup property page. 

See below for how to search in the lookup file. 

 
Esc Exit data editing. 

HOW TO SEARCH IN THE LOOKUP FILE? 

1) Select the value of field 1 as Code, which is the key field defined on the Lookup 
property page of the template file. 

2) Replace the original value with the new value that you want to search for, say, 8071. 

   →    

3) Tap  to start searching 8071 specified in the lookup .txt file. 

1 2
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4) If successful, it will display a “Data found!” message. Tap [OK]. 

5) Based on the new value, the whole specified data for 8071 is displayed. 

   →   

HOW TO VIEW OR UPDATE THE IMAGE FILE? 

1) Tap  to view the image. 

2) When the image is displayed, tap  on the screen to select another image, or tap 

 to get ready for capturing a new image. 

   →   

The icons on the toolbar, from left to right, are explained in the table below. 

4 

1 

2

3 

3 

5 
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Button Description 

 
Open an image. Any existing file in the following formats can be viewed —  

 JPEG 

 Bitmap 

 PNG 

 GIF 

 
Save the opened image to a different file name or format. 

 
 Enter the Camera Preview Mode  

 Display a camera preview image 

 Capture a image 

 
Exit the Camera Preview Mode. 

 
Configure camera settings if necessary. 

3) Tap [OK]. 

A dialog box appears requesting you to confirm whether to update the image. Tap 
[Yes] to update the record with new image or [No] to keep the original image. 

  →   
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DELETE 

You can manually delete a data file or lookup file if it is not desired any more.  

  →   
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SETTINGS 

You can change system settings directly on the mobile computer. Refer to 5.4 System 
Initial Settings. 

  →   

ABOUT 

View the version information. 

  →   
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The tables below list reader settings as well as symbology settings for the Linear Laser 
(SE955) scan engine.  

READER SETTINGS TABLE 

Laser Engine Description Default 

Scan Angle Wide 

Wide Angle Select the scan angle for Long Range Laser scan engine. “Wide Angle” is 
for 47°. 

Narrow Angle Select the scan angle for Long Range Laser scan engine. “Narrow Angle” is 
for 35°. 

Redundancy Level Level 1 

Level 1 Following barcodes must be successfully read twice before being decoded: 

Barcode Types Code Length 

Codabar All 

MSI 4 characters or less 

Industrial 25 (Discrete 25) 8 characters or less 

Interleaved 25 8 characters or less  
Level 2 All barcodes must be successfully read twice before being decoded. 

Level 3 All barcodes except for the following barcodes must be successfully read 
twice before being decoded. Following barcodes must be read three times: 

Barcode Types “Excluded” Code Length 

MSI 4 characters or less 

Industrial 25 (Discrete 25) 8 characters or less 

Interleaved 25 8 characters or less  
Level 4 All barcodes must be successfully read three times before being decoded. 

Barcode Good Read Sound 2 

Mute, or Sound 1~9 A sound reminder to prove a good read.  

Scan Mode Laser  

Laser Mode Hold down the scan trigger to start with scanning. 

 The scanning won’t stop until (a) a barcode is read, (b) the preset 
timeout expires, or (c) you release the trigger. 

  

  

Appendix II 
LASER (SE955) 
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Continuous Mode Non-stop scanning 

 To decode the same barcode repeatedly, move away the scan beam 
and target it at the barcode for each scanning. 

Decode Time-out 

1~9 (second) Set the maximum time for decoding to continue during a 
scan attempt. 

3 sec. 

Good Read Led Duration 0 sec. 

Same Barcode Time-out 

0.0~9.9 (second) When in Continuous mode, set the minimum time that 
must stop detect before the scan engine decodes a second 
same barcode. This reduces the risk of accidentally 
scanning the same barcode twice. 

1.0 sec. 

Transmit code ID None 

None Do not use any Transmit code ID. 

AIM code ID character Each AIM Code ID contains the three-character string “]cm” –  

 ] = Flag Character (ASCII 93) 

 c = Code Character (see below) 

 m = Modifier Character (see below) 

AIM CODE ID – CODE CHARACTERS 

Code Character Code Type 

A Code 39, Code 39 Full ASCII, Code 32 

C Code 128, Coupon (Code 128 portion) 

d Data Matrix 

E UPC/EAN, Coupon (UPC portion) 

e GS1 DataBar (RSS) 

F Codabar 

G Code 93 

H Code 11 

I Interleaved 25 

L PDF417, Macro PDF417, Micro PDF417 

M MSI 

Q QR Code 

S Industrial 25 (Discrete 25), IATA 2 of 5 

U Maxicode 

X Code 39 Trioptic, Bookland EAN, US Postnet, US Planet, UK Postal, Japan 
Postal, Australian Postal, Dutch Postal 

AIM CODE ID – MODIFIER CHARACTERS 
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Code Type Option Value Option 

0 No check character or Full ASCII processing. 

1 Check digit has been verified. 

3 Check digit has been verified and stripped. 

4 Full ASCII conversion has been performed. 

5 Result of option values 1 and 4. 

Code 39 

7 Result of option values 3 and 4. 

0 Standard data packet. No Function Code 1“FNC1” in the first 
character position. 

1 Function Code 1“FNC1” in the first character position. 

Code 128 

2 Function Code 1“FNC1” in the second character position. 

0 No check digit processing. 

1 Check digit has been verified. 

Interleaved 25 

3 Check digit has been verified and stripped. 

Codabar 0 No check digit processing. 

Code 93 0 Always transmit 0. 

0 Modulo 10 check digit verified and transmitted. MSI 

1 Modulo 10 check digit verified but not transmitted. 

Industrial 25 
(Discrete 25) 

0 Always transmit 0. 

0 Standard data packet in full EAN country code format, which 
is 13 digits for UPC-A and UPC-E (not including addons). 

3 Standard data packet with two-digit or five-digit addons. 

4 EAN-8 data packet. 

UPC/EAN 

A UPC-A with Addon 2 barcode, 012345678905-10, is transmitted to the 
host as a 18-character string, ]E3001234567890510. 

Bookland EAN 0 Always transmit 0. 

Trioptic Code 39 0 Always transmit 0. 

0 Single check digit (has been verified.) 

1 Two check digits (has been verified.) 

Code 11 

3 Check digit has been verified but not transmitted. 

0 Always transmit 0. GS1 DataBar 
(RSS) 

RSS-14 and RSS Limited will be transmitted with an Application Identifier 
“01”. For example, an RSS-14 barcode, 10012345678902, is transmitted 
as ]e00110012345678902. 

Note: In GS1-128 emulation mode, RSS is transmitted using Code 128 rules (= “]C1”). 

EAN.UCC Native mode transmission 
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0 Standard data packet 

1 Data packet containing the data following an encoded 
symbol separator character. 

2 Data packet containing the data following an escape 
mechanism character. The data packet does not support the 
ECI protocol. 

3 Data packet containing the data following an escape 
mechanism character. The data packet supports the ECI 
protocol. 

GS1-128 emulation 

Composites (RSS, 
GS1-128, 2D 
portion of UPC 
composite) 

1 Data packet is a GS1-128 barcode (= data is preceded with 
“]JC1”). 

Note: UPC portion of composite is transmitted using UPC rules. 

0 Scan engine is set to conform to protocol defined in 1994 
PDF417 symbology specifications.  

 When this option is transmitted, the receiver cannot 
reliably determine whether ECIs have been invoked or 
whether data byte 92DEC has been doubled in 
transmission. 

1 Scan engine is set to follow the ECI protocol (Extended 
Channel Interpretation). All data characters 92DEC are 
doubled. 

2 Scan engine is set for Basic Channel operation (no escape 
character transmission protocol). Data characters 92DEC are 
not doubled.  

 When decoders are set to this mode, unbuffered Macro 
symbols and symbols requiring the decoder to convey 
ECI escape sequences cannot be transmitted. 

3 The barcode contains a GS1-128 symbol, and the first 
codeword is 903-907, 912, 914, 915. 

4 The barcode contains a GS1-128 symbol, and the first 
codeword is in the range 908-909. 

5 The barcode contains a GS1-128 symbol, and the first 
codeword is in the range 910-911. 

PDF417,  

Micro PDF417 

A PDF417 barcode, ABCD, with no transmission protocol enabled, is 
transmitted as ]L2ABCD. 

0 ECC 000-140, not supported. 

1 ECC 200. 

2 ECC 200, FNC1 in first or fifth position. 

3 ECC 200, FNC1 in second or sixth position. 

4 ECC 200, ECI protocol implemented. 

Data Matrix 

5 ECC 200, FNC1 in first or fifth position, ECI protocol 
implemented. 



  97 

 

 Appendix II  Laser (SE955) 

 

6 ECC 200, FNC1 in second or sixth position, ECI protocol 
implemented. 

0 Mode 4 or 5 

1 Mode 2 or 3 

2 Mode 4 or 5, ECI protocol implemented. 

Maxicode 

3 Mode 2 or 3, ECI protocol implemented in secondary 
message. 

0 Model 1 

1 Model 2, ECI protocol not implemented. 

2 Model 2, ECI protocol implemented. 

3 Model 2, ECI protocol not implemented, FNC1 implied in first 
position. 

4 Model 2, ECI protocol implemented, FNC1 implied in first 
position. 

5 Model 2, ECI protocol not implemented, FNC1 implied in 
second position. 

QR Code 

6 Model 2, ECI protocol implemented, FNC1 implied in second 
position 

Note: (1) For JPEG files, these BPP settings are ignored for it always uses 8 bits per pixel!
 (2) When the Camera feature is enabled, press the [SCAN] button and it will 
capture an image instead of reading a barcode. 

SYMBOLOGY SETTINGS TABLE 

Laser Engine Description Default 

Code 39 Enable 

Convert to Code 32 Convert to Italian Pharmacode. No 

Code 32 Prefix Prefix character “A” to Code 32 barcodes. 

  “Convert to Code 32” must be enabled. 

No 

Verify Check Digit Decide whether to verify the check digit. If the check digit 
is incorrect, the barcode will not be accepted. 

No 

Transmit Check Digit Decide whether to include the check digit in the data being 
transmitted. 

 “Verify Check Digit” must be enabled. 

No 

Code 39 Full ASCII Code 39 Full ASCII includes all the alphanumeric and 
special characters. 

No 

Trioptic 39 Decide whether to decode Trioptic Code 39. 

 Trioptic Code 39 is a variant of Code 39 used in the 
marking of computer tape cartridges. It always 
contains six characters. 

No 
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--- 

4 

4, 55 

Select Length   Any Length 

 One Length 

 Two Lengths 

 Range (Min/ Max) 
4~55 

Industrial 25  Enable 

--- 

4 

4, 55 

Select Length   Any Length 

 One Length 

 Two Lengths 

 Range (Min/ Max) 
4~55 

Interleaved 25 Enable 

Verify Check Digit Decide whether to verify the check digit. If desired, select 
one of the algorithms below. If the check digit is incorrect, 
the barcode will not be accepted. 

No 

Transmit Check Digit Decide whether to include the check digit in the data being 
transmitted. 

 “Verify Check Digit” must be enabled. 

No 

Convert to EAN-13 Convert a 14-character barcode into EAN-13 if the 
following requirements are met: 

 The barcode must have a leading 0 and a valid EAN-13 
check digit. 

No 

--- 

4 

4, 55 

Select Length   Any Length 

 One Length 

 Two Lengths 

 Range (Min/ Max) 
4~55 

Chinese 25 Enable 

Codabar Enable 

CLSI Editing When applied, the CLSI editing strips the start/stop 
characters and inserts a space after the first, fifth, and 
tenth characters of a 14-character Codabar barcode. 

 The 14-character barcode length does not include 
start/stop characters. 

No 

NOTIS Editing Decide whether to include the start/stop characters in the 
data being transmitted. 

 NOTIS Editing is to strip the start/stop characters, i.e. 
to disable “Transmit Start/Stop Characters”. 

No 

--- 

4 

4, 55 

Select Length   Any Length 

 One Length 

 Two Lengths 

 Range (Min/ Max) 
4~55 
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MSI Enable 

Transmit Check Digit Decide whether to include the check digit in the data being 
transmitted.  

No 

Check digit verification If Two Check Digits option is selected, an additional 
verification is required to ensure integrity. Select one of 
the algorithms below. If the check digit is incorrect, the 
barcode will not be accepted. 

Single Modulo 
10 

Check Digits One Check Digit Single Modulo 10 

Two Check Digits  Mod 10/Mod 11 

 Mod 10/Mod 10  

--- 

--- 

4 

4, 55 

Select Length   Any Length 

 One Length 

 Two Lengths 

 Range (Min/ Max) 
4~55 

Code 128 Enable 

GS1-128 (EAN 128) Enable 

Replace Field separator Decide whether to replace the field separator. If the 
barcode contains Field Separator “0x1D”, it will be 
changed to the desired Field Separator. For example, type 
the desired character “;” (semicolon) as the new field 
separator. Then if the barcode contains Field Separator 
“0x1D”, it will be changed to “;”. 

No 

ISBT 128 Enable 

UPC-A Enable 

Transmit Preamble Decide whether to include the UPC-A preamble System 
Number (and Country Code) in the data being transmitted. 

 No Preamble 

 System Character 

 System Character & Country Code 

System 
Character 

Enable Addons Decide whether to decode UPC-A with addons. 

 Ignore Addons 

 Decode Only With Addons  

 Auto-discriminate 

Ignore 
Addons 

Addons Redundancy When “Auto-discriminate” is applied, decide the number of 
times (2~30) of supplementary decoding the same 
barcode that makes a valid reading. 

7 times 

Transmit Check Digit Decide whether to include the UPC-A check digit in the 
data being transmitted. 

Yes 
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UPC-E0 Enable 

Transmit Preamble Decide whether to include the UPC-A preamble System 
Number (and Country Code) in the data being transmitted. 

 No Preamble 

 System Character 

 System Character & Country Code 

System 
Character 

Enable Addons Decide whether to decode UPC-A with addons. 

 Ignore Addons 

 Decode Only With Addons  

 Auto-discriminate 

Ignore 
Addons 

Addons Redundancy When “Auto-discriminate” is applied, decide the number of 
times (2~30) of supplementary decoding the same 
barcode that makes a valid reading. 

7 times 

Transmit Check Digit Decide whether to include the UPC-A check digit in the 
data being transmitted. 

Yes 

Convert to UPC-A The UPC-E0 barcode will be expanded into UPC-A, and the 
next processing will follow the settings configured for 
UPC-A. 

No 

UPC-E1 Disable 

Transmit Preamble Decide whether to include the UPC-A preamble System 
Number (and Country Code) in the data being transmitted. 

 No Preamble 

 System Character 

 System Character & Country Code 

System 
Character 

Enable Addons Decide whether to decode UPC-A with addons. 

 Ignore Addons 

 Decode Only With Addons  

 Auto-discriminate 

Ignore 
Addons 

Addons Redundancy When “Auto-discriminate” is applied, decide the number of 
times (2~30) of supplementary decoding the same 
barcode that makes a valid reading. 

7 times 

Transmit Check Digit Decide whether to include the UPC-A check digit in the 
data being transmitted. 

Yes 

Convert to UPC-A The UPC-E1 barcode will be expanded into UPC-A, and the 
next processing will follow the settings configured for 
UPC-A. 

No 

EAN-8 Enable 

Enable Addons Decide whether to decode UPC-A with addons. 

 Ignore Addons 

 Decode Only With Addons  

 Auto-discriminate 

Ignore 
Addons 

Addons Redundancy When “Auto-discriminate” is applied, decide the number of 
times (2~30) of supplementary decoding the same 
barcode that makes a valid reading. 

7 times 
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Convert to EAN-13 The EAN-8 barcode will be expanded into EAN-13, and the 
next processing will follow the settings configured for 
EAN-13. 

No 

EAN-13 Enable 

Enable Addons Decide whether to decode UPC-A with addons. 

 Ignore Addons 

 Decode Only With Addons  

 Auto-discriminate 

Ignore 
Addons 

Addons Redundancy When “Auto-discriminate” is applied, decide the number of 
times (2~30) of supplementary decoding the same 
barcode that makes a valid reading. 

7 times 

Bookland EAN Enable 

GS1 DataBar-14 Enable 

Cover GS1 DataBar 
14/Limited to UPC/EAN 

GS1 DataBar-14 is short for GS1 DataBar Omnidirectional. 
This group consists of (1) GS1 DataBar Omnidirectional, 
(2) GS1 DataBar Truncated, (3) GS1 DataBar Stacked, and 
(4) GS1 DataBar Stacked Omnidirectional. 

“Convert to UPC/EAN” only applies to GS1 Databar-14 and 
GS1 Databar Limited barcodes not decoded as part of a 
Composite barcode. 

Convert to EAN-13 

Strip the leading “010” from barcodes.  

 “01” is the Application ID and must be followed by a 
single zero (the first digit encoded) 

Convert to UPC-A 

Strip the leading “0100” from barcodes.  

 “01” is the Application ID and must be followed by 
two or more zeros (but not six zeros)  

No 

GS1 DataBar Limited Enable 

GS1 DataBar Expanded Enable 

Code 93 Enable 

--- 

4 

4, 55 

Select Length   Any Length 

 One Length 

 Two Lengths 

 Range (Min/ Max) 
4~55 

Code 11 Enable 

Verify Check Digit Decide whether to verify the check digit. If the check digit 
is incorrect, the barcode will not be accepted. 

 No verification 

 One Check Digit 

 Two Check Digits 

No verification 
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Transmit Check Digit Decide whether to include the check digit in the data being 
transmitted. 

 “Verify Check Digit” must be enabled. 

No 

--- 

4 

4, 55 

Select Length   Any Length 

 One Length 

 Two Lengths 

 Range (Min/ Max) 
4~55 

Coupon Code Disable 

Read UPC-A barcodes starting with digit “5”, EAN-13 barcodes starting with digits “99”, and 
GS1-128 (EAN 128) Coupon Codes. 

 UPC-A and EAN-13 must be enabled first! 

 Use “Addon Redundancy” to control auto-discrimination of the GS1-128 (right half) of a coupon 
code. 
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The tables below list reader settings as well as symbology settings for the 2D scan 
engine.  

READER SETTINGS TABLE 

2D Engine Description Default 

Barcode Good Read Sound 2 

Mute, or Sound 1~9 A sound reminder to prove a good read.  

Redundancy Level Level 1 

Level 1 Following barcodes must be successfully read twice before being decoded: 

Barcode Types Code Length 

Codabar All 

MSI 4 characters or less 

Industrial 25 (Discrete 25) 8 characters or less 

Interleaved 25 8 characters or less  
Level 2 All barcodes must be successfully read twice before being decoded. 

Level 3 All barcodes except for the following barcodes must be successfully read 
twice before being decoded. Following barcodes must be read three times: 

Barcode Types “Excluded” Code Length 

MSI 4 characters or less 

Industrial 25 (Discrete 25) 8 characters or less 

Interleaved 25 8 characters or less  
Level 4 All barcodes must be successfully read three times before being decoded. 

Decode Time-out 

1~9 (second) Set the maximum time for decoding to continue during a 
scan attempt. 

3 sec. 

Good Read Led Duration 0 sec. 

Security Level Level 0 

Level 0 This default setting allows the scan engine to operate in its most 
aggressive state, providing sufficient security in decoding most “in-spec” 
barcodes. 

Level 1 Select this option if misdecodes occur. This level should eliminate most 
misdecodes. 

  

Appendix III 
2D IMAGER (SE4500) 
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Level 2 Select this option if Security Level 1 fails to eliminate misdecodes. 

Level 3 Select this option if Security Level 2 also fails to eliminate misdecodes. 
However, selecting this option impairs the decoding ability of the scan 
engine. If this level of security is necessary, try to improve the barcode 
quality. 

Transmit code ID None 

None Do not use any Transmit code ID. 

AIM code ID character Each AIM Code ID contains the three-character string “]cm” –  

 ] = Flag Character (ASCII 93) 

 c = Code Character  

 m = Modifier Character  

For more information, please refer to AIM Code ID – Code Characters 

SYMBOLOGY SETTINGS TABLE 

1D SYMBOLOGIES 

2D Engine Description Default 

UPC-A Enable 

Transmit Preamble Decide whether to include the UPC-A preamble System 
Number (and Country Code) in the data being transmitted. 

 No Preamble 

 System Character 

 System Character & Country Code 

System 
Character 

Enable Addons Decide whether to decode UPC-A with addons. 

 Ignore Addons 

 Decode Only With Addons  

 Auto-discriminate 

Ignore 
Addons 

Addons Redundancy When “Auto-discriminate” is applied, decide the number of 
times (2~30) of supplementary decoding the same 
barcode that makes a valid reading. 

10 times 

Transmit Check Digit Decide whether to include the UPC-A check digit in the 
data being transmitted. 

Yes 

UPC-E0 Enable 

Transmit Preamble Decide whether to include the UPC-A preamble System 
Number (and Country Code) in the data being transmitted. 

 No Preamble 

 System Character 

 System Character & Country Code 

System 
Character 
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Enable Addons Decide whether to decode UPC-A with addons. 

 Ignore Addons 

 Decode Only With Addons  

 Auto-discriminate 

Ignore 
Addons 

Addons Redundancy When “Auto-discriminate” is applied, decide the number of 
times (2~30) of supplementary decoding the same 
barcode that makes a valid reading. 

10 times 

Transmit Check Digit Decide whether to include the UPC-A check digit in the 
data being transmitted. 

Yes 

Convert to UPC-A The UPC-E0 barcode will be expanded into UPC-A, and the 
next processing will follow the settings configured for 
UPC-A. 

No 

UPC-E1 Disable 

Transmit Preamble Decide whether to include the UPC-A preamble System 
Number (and Country Code) in the data being transmitted. 

 No Preamble 

 System Character 

 System Character & Country Code 

System 
Character 

Enable Addons Decide whether to decode UPC-A with addons. 

 Ignore Addons 

 Decode Only With Addons  

 Auto-discriminate 

Ignore 
Addons 

Addons Redundancy When “Auto-discriminate” is applied, decide the number of 
times (2~30) of supplementary decoding the same 
barcode that makes a valid reading. 

10 times 

Transmit Check Digit Decide whether to include the UPC-A check digit in the 
data being transmitted. 

Yes 

Convert to UPC-A The UPC-E1 barcode will be expanded into UPC-A, and the 
next processing will follow the settings configured for 
UPC-A. 

No 

EAN-8 Enable 

Enable Addons Decide whether to decode UPC-A with addons. 

 Ignore Addons 

 Decode Only With Addons  

 Auto-discriminate 

Ignore 
Addons 

Addons Redundancy When “Auto-discriminate” is applied, decide the number of 
times (2~30) of supplementary decoding the same 
barcode that makes a valid reading. 

10 times 

Convert to EAN-13 The EAN-8 barcode will be expanded into EAN-13, and the 
next processing will follow the settings configured for 
EAN-13. 

No 
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EAN-13 Enable 

Enable Addons Decide whether to decode UPC-A with addons. 

 Ignore Addons 

 Decode Only With Addons  

 Auto-discriminate 

Ignore 
Addons 

Addons Redundancy When “Auto-discriminate” is applied, decide the number of 
times (2~30) of supplementary decoding the same 
barcode that makes a valid reading. 

10 times 

Bookland EAN Enable 

Code 128 Enable 

GS1-128 (EAN 128) Enable 

Replace Field separator Decide whether to replace the field separator. If the 
barcode contains Field Separator “0x1D”, it will be 
changed to the desired Field Separator. For example, type 
the desired character “;” (semicolon) as the new field 
separator. Then if the barcode contains Field Separator 
“0x1D”, it will be changed to “;”. 

No 

ISBT 128 Enable 

Concatenation Decide whether to decode and concatenate pairs of ISBT 
barcodes. 

 Disable 

 Enable – When this option is selected, there must be 
two ISBT barcodes for the scanner to decode and 
perform concatenation. 

 Auto-discriminate – When this option is selected, the 
scanner decodes and concatenates pairs of ISBT 
barcodes immediately. If only a single ISBT barcode is 
present, the scanner must decode 10 times before 
transmitting its data to confirm that there is no 
additional ISBT barcode. 

Disable 

Concatenation 
Redundancy 

When “Auto-discriminate” is applied, decide the 
concatenation redundancy (2~20 times). 

10 times 

Code 39 Enable 

Convert to Code 32 Convert to Italian Pharmacode. No 

Code 32 Prefix Prefix character “A” to Code 32 barcodes. 

  “Convert to Code 32” must be enabled. 

No 

Verify Check Digit Decide whether to verify the check digit. If the check digit 
is incorrect, the barcode will not be accepted. 

No 

Transmit Check Digit Decide whether to include the check digit in the data being 
transmitted. 

 “Verify Check Digit” must be enabled. 

No 

Code 39 Full ASCII Code 39 Full ASCII includes all the alphanumeric and 
special characters. 

No 
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Trioptic 39 Decide whether to decode Trioptic Code 39. 

 Trioptic Code 39 is a variant of Code 39 used in the 
marking of computer tape cartridges. It always 
contains six characters. 

No 

Code39/Codabar: 
Inter-Character Gap 

The Code 39 and Codabar symbologies have an 
intercharacter gap that is typically quite small. Due to 
various barcode printing technologies, this gap can grow 
larger than the maximum size allowed, preventing the 
scan engine from decoding a barcode. 

If this problem occurs, set it to “Large Intercharacter 
Gaps” to tolerate these out-of-specification barcodes. 

 Normal  

 Large  

Normal 

--- 

4 

4, 55 

Select Length   Any Length 

 One Length 

 Two Lengths 

 Range (Min/ Max) 
4~55 

Code 93 Enable 

--- 

4 

4, 55 

Select Length   Any Length 

 One Length 

 Two Lengths 

 Range (Min/ Max) 
4~55 

Codabar Enable 

CLSI Editing When applied, the CLSI editing strips the start/stop 
characters and inserts a space after the first, fifth, and 
tenth characters of a 14-character Codabar barcode. 

 The 14-character barcode length does not include 
start/stop characters. 

No 

NOTIS Editing Decide whether to include the start/stop characters in the 
data being transmitted. 

 NOTIS Editing is to strip the start/stop characters, i.e. 
to disable “Transmit Start/Stop Characters”. 

No 

Code39/Codabar: 
Inter-Character Gap 

The Code 39 and Codabar symbologies have an 
intercharacter gap that is typically quite small. Due to 
various barcode printing technologies, this gap can grow 
larger than the maximum size allowed, preventing the 
scan engine from decoding a barcode. 

If this problem occurs, set it to “Large Intercharacter 
Gaps” to tolerate these out-of-specification barcodes. 

 Normal  

 Large  

Normal 
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--- 

4 

4, 55 

Select Length   Any Length 

 One Length 

 Two Lengths 

 Range (Min/ Max) 
4~55 

Industrial 25  Enable 

--- 

4 

4, 55 

Select Length   Any Length 

 One Length 

 Two Lengths 

 Range (Min/ Max) 
4~55 

Interleaved 25 Enable 

Verify Check Digit Decide whether to verify the check digit. If desired, select 
one of the algorithms below. If the check digit is incorrect, 
the barcode will not be accepted. 

No 

Transmit Check Digit Decide whether to include the check digit in the data being 
transmitted. 

 “Verify Check Digit” must be enabled. 

No 

Convert to EAN-13 Convert a 14-character barcode into EAN-13 if the 
following requirements are met: 

 The barcode must have a leading 0 and a valid EAN-13 
check digit. 

No 

--- 

4 

4, 55 

Select Length   Any Length 

 One Length 

 Two Lengths 

 Range (Min/ Max) 
4~55 

GS1 DataBar-14 Enable 

Cover GS1 DataBar 
14/Limited to UPC/EAN 

GS1 DataBar-14 is short for GS1 DataBar Omnidirectional. 
This group consists of (1) GS1 DataBar Omnidirectional, 
(2) GS1 DataBar Truncated, (3) GS1 DataBar Stacked, and 
(4) GS1 DataBar Stacked Omnidirectional. 

“Convert to UPC/EAN” only applies to GS1 Databar-14 and 
GS1 Databar Limited barcodes not decoded as part of a 
Composite barcode. 

Convert to EAN-13 

Strip the leading “010” from barcodes.  

 “01” is the Application ID and must be followed by a 
single zero (the first digit encoded) 

Convert to UPC-A 

Strip the leading “0100” from barcodes.  

 “01” is the Application ID and must be followed by 
two or more zeros (but not six zeros)  

No 

GS1 DataBar Limited Enable 
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GS1 DataBar Expanded Enable 

MSI Enable 

Transmit Check Digit Decide whether to include the check digit in the data being 
transmitted.  

No 

Check Digits If Two Check Digits option is selected, an additional 
verification is required to ensure integrity. Select one of 
the algorithms below. If the check digit is incorrect, the 
barcode will not be accepted. 

One Check 
Digit 

Check Algorithm One Check Digit Single Modulo 10 

Two Check Digits  Mod 10/Mod 11 

 Mod 10/Mod 10  

Mod10/Mod 
10 

--- 

4 

4, 55 

Select Length   Any Length 

 One Length 

 Two Lengths 

 Range (Min/ Max) 
4~55 

Code 11 Enable 

Verify Check Digit Decide whether to verify the check digit. If the check digit 
is incorrect, the barcode will not be accepted. 

 No verification 

 One Check Digit 

 Two Check Digits 

No verification 

Transmit Check Digit Decide whether to include the check digit in the data being 
transmitted. 

 “Verify Check Digit” must be enabled. 

No 

--- 

4 

4, 55 

Select Length   Any Length 

 One Length 

 Two Lengths 

 Range (Min/ Max) 
4~55 

Matrix 25 Enable 

Enable Decode 
Redundancy 

Decide whether to enable read redundancy.  No 

Verify Check Digit Decide whether to verify the check digit. If the check digit 
is incorrect, the barcode will not be accepted. 

No 

Transmit Check Digit Decide whether to include the check digit in the data being 
transmitted. 

 “Verify Check Digit” must be enabled. 

No 

--- 

4 

4, 55 

Select Length   Any Length 

 One Length 

 Two Lengths 

 Range (Min/ Max) 
4~55 
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Chinese 25 Enable 

Coupon Code Enable 

Read UPC-A barcodes starting with digit “5”, EAN-13 barcodes starting with digits “99”, and 
GS1-128 (EAN 128) Coupon Codes. 

 UPC-A and EAN-13 must be enabled first! 

 Use “Addon Redundancy” to control auto-discrimination of the GS1-128 (right half) of a coupon 
code. 

Postal Codes 

US Postnet  Enable 

US Planet  Enable 

Transmit US Postal 
Check Digit 

US Postnet or US Planet must be enabled first! Enable 

UK Postal  Enable 

Transmit UK Postal 
Check Digit 

UK Postal must be enabled first! Enable 

Japan Postal  Enable 

Australian Postal  Enable 

Dutch Postal  Enable 

Composite Codes 

Composite CC-C  Enable 

Composite CC-A/B  Disable 

Composite TLC-39  Disable 

GS1-128 Emulation 
Mode  

Transmit UCC/EAN Composite Code data as if it was 
encoded in GS1-128 barcodes. 

Disable 

UPC Composite Mode UPC barcodes can be “linked” with a 2D barcode during 
transmission as if they were one barcode. 

UPC Never Linked 

Transmit UPC barcodes regardless of whether a 2D 
barcode is detected. 

UPC Always Linked 

Transmit UPC barcodes and the 2D portion. If the 2D 
portion is not detected, the UPC barcode will not be 
transmitted. 

 CC-A/B or CC-C must be enabled! 

Auto-discriminate UPC Composites 

Transmit UPC barcodes as well as the 2D portion if 
present.  

UPC Always 
Linked 
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2D SYMBOLOGIES 

2D Engine Description Default 

2D Symbologies 

PDF417  Enable 

Maxicode  Enable 

MicroQR  Enable 

MicroPDF417  Disable 

Code 128 Emulation Transmit data from certain MicroPDF417 barcodes as if it 
was encoded in Code 128 barcodes.  

 Transmit AIM Code Identifier must be enabled first! 

 MicroPDF417 must be enabled first! 

When applied, the MicroPDF417 barcodes are transmitted 
with one of these prefixes: 

The first codeword of MicroPDF417 is 903-907, 912, 914, 
915: 

The original Code ID “]L3” will be changed to “]C1”. 

The first codeword of MicroPDF417 is 908 or 909: 

The original Code ID “]L4” will be changed to “]C2”. 

The first codeword of MicroPDF417 is 910 or 911: 

The original Code ID “]L5” will be changed to “]C0”.  

Disable 

Data Matrix  Enable 

Data Matrix Inverse Decide whether to decode Data Matrix Inverse. 

Regular Only 

Decode regular Data Matrix barcodes only. 

Inverse Only 

Decode inverse Data Matrix barcodes only. 

Inverse Autodetect 

Decode both regular and inverse Data Matrix barcodes. 
 

Regular Only 

QR Code  Enable 
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QR Code Inverse Decide whether to decode QR Code Inverse. 

Regular Only 

Decode regular QR Code only. 

Inverse Only 

Decode inverse QR Code only. 

Inverse Autodetect 

Decode both regular and inverse QR Code. 
 

Regular Only 

Aztec  Enable 

Aztec Inverse Decide whether to decode Aztec Inverse. 

Regular Only 

Decode regular Aztec barcodes only. 

Inverse Only 

Decode inverse Aztec barcodes only. 

Inverse Autodetect 

Decode both regular and inverse Aztec barcodes. 
 

Regular Only 

Macro PDF --- 

Macro PDF is a special feature for concatenating multiple PDF barcodes into one file, known as 
Macro PDF417 or Macro MicroPDF417.  

Transmit/Decode Mode 
Symbols 

Decide how to handle Macro PDF decoding. 

Buffer All Symbols / Transmit Macro PDF When Complete 

Transmit all decoded data from an entire Macro PDF 
sequence only when the entire sequence is scanned and 
decoded. If the decoded data exceeds the limit of 50 
symbols, no transmission because the entire sequence 
was not scanned! 

 The transmission of the control header must be 
disabled. 

Transmit Any Symbol in Set / No Particular Order 

Transmit data from each Macro PDF symbol as decoded, 
regardless of the sequence.  

 The transmission of the control header must be 
enabled. 

Pass through All Symbols 

Transmit and decode all Macro PDF symbols and 
perform no processing. In this mode, the host is 
responsible for detecting and parsing the Macro PDF 
sequences.  

Pass through 
All Symbols 
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Escape Characters When enabled, it uses the backslash “\” as an Escape 
character for systems that can process transmissions 
containing special data sequences. It will format special 
data according to the Global Label Identifier (GLI) 
protocol, which only affects the data portion of a Macro 
PDF symbol transmission. The Control Header, if enabled, 
is always sent with GLI formatting. 

 None 

 GLI Protocol 

None 

Note: When printing barcodes, keep each Macro PDF sequence separate, as each has a 
unique identifier. Do not mix barcodes from several Macro PDF sequences, even if 
they encode the same data. When you scan Macro PDF sequences, scan the entire 
Macro PDF sequence without interruption! 
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